
When you join a photographic club or society there appears to be a puzzling range of skills 

you need to learn and one of those is how to prepare your photographs so you can enter 

them into a range of photographic PDI competitions.

As with many situations in life, a new skill or technique seems hard to understand until you receive a little help 

and guidance and only then discover it isn’t so difficult after all. This is definitely the case when preparing your 

photographs for projection in local, national or international competitions because it isn’t possible to simply 

capture an image, edit it to create your ‘winning’ photograph then save and submit it in the hope you do well. 

Before you enter, there are four basic rules you must follow and this means your digital photograph must:

1. be saved as a JPEG (.jpg) file with the quality set to the highest setting

2. have recommend pixel dimensions - a maximum of 1600 pixels wide or 1200 pixels in height

3. use the sRGB colour space in common with most digital cameras, projectors and the Internet

4. contain at least the title and your name in the hidden data embedded within the image

If photographs you submit to competitions, including those at WPS, do not follow these rules your entries will 

not be eligible and may be disqualified. At first this seems somewhat harsh but the rules exist to ensure entries 

are in a standard format to allow the judges to compare entries to a common standard. Specifying the specific 

pixel dimensions and the sRGB colour space, for example, means your image will match the display capabilities 

of the projector, be viewed at its clearest and sharpest and with colours as close as possible to those you 

intended. Insisting the title and your name is included in the hidden EXIF/IPTC data means display software 

during judging can read your title and name and a photograph is then always marked as being yours.

What is in this guide

The information here covers what you need to know to prepare your photographs for PDI competitions using a 

range of software titles including Photoshop, Lightroom, Photoshop Elements and Affinity Photo. As you’ll see, the 

process is relatively similar for all the titles included so if the software you own isn’t covered you should still be 

able to see what’s needed from the instructions given here. There is even a section included on how to insert 

your photo title and name into the IPTC data using the facilities provided by Windows on a PC. Finally, this guide 

explains how to submit your entry into WPS competitions.

Each section can be printed independently if needed so you’ll find figure numbers repeated in each section to 

allow for this.
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Wolverhampton Photographic Society

Preparing Photographs for
Projected Digital Image Competitions
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A Few Relevant Terms

Pixel:  The smallest unit of a digital image that can be displayed and represented on a digital display device.

JPEG file:  Pronounced jay-peg, this is a popular image file format commonly used to store photos since it 

supports 16 million colours and can have varying levels of compression. This makes it ideal where storage space 

is limited or for faster-viewing of web sites which include a high number of digital images.

EXIF/IPTC data:  A standard way of tagging image files with additional information and is most commonly seen in 

JPEG images captured with digital cameras. EXIF data, such as exposure settings, date/time or GPS location, is 

written to the file by the camera whereas IPTC data, such as a title, copyright information or search key-words, are 

added using image cataloguing or editing software. EXIF/IPTC data is also referred to as metadata.

Colour Space:  A system for describing colour numerically. The most widely used colour spaces are sRGB for 

scanners, cameras and displays, CMYK for colour printing and YUV for TV and video. Devices using the same colour 

space should display specific colours similarly and  with the same tonal range.

More About Colour Space

When an image is captured by a digital camera, colours are converted to dots (pixels) and each of these is stored 

as a number which specifies its colour. In order to ensure a digital image will look the same on different display 

devices an agreed standard was created which specifies that a particular shade of green or yellow, for example, 

will display the same whatever is used to show the image. This first agreed standard was known as ‘Standard Red 

Green and Blue’ or sRGB and even today this is still the standard used by a wide range of devices including the 

Internet, digital projectors and, therefore, PDI competitions. Printed photographs use a different colour space.

Other display colour spaces have since 

been defined which have a wider 

colour range (gamut) than sRGB. These 

diagrams use triangles to indicate the 

range of colours each can represent.

Many digital cameras give a choice 

between using sRGB and Adobe RGB to 

capture an image so if Adobe RGB allows the camera to record a greater range of colours, is this the best camera 

setting to use? If you are displaying your photos on a phone, on a screen or projector or uploading them to a web 

site or social media platform it would be best to stick with sRGB because that is the colour space they use.

Understanding and managing different colour spaces can be tricky, especially when dealing with what happens 

when one colour space is converted to another. Colours will look wrong if you incorrectly mix and match colour 

spaces so that, for example, colour will look dull and flat if you display an image which uses Adobe RGB on a device 

which uses sRGB. The upshot of this is it’s probably wise to ensure your camera and editing software use sRGB.

It really is important you save your PDI using the sRGB colour space otherwise the colours may look dull and flat 

when projected. If you want to know more about colour spaces a quick Google search will provide all you need!

Wolverhampton Photographic Society

Helpful Background Information
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Wolverhampton Photographic Society

Preparing PDI Photographs Using
Adobe Lightroom

The information provided here is based on Lightroom CC for Windows but the way in which you prepare your 

photographs hasn’t really changed so these instructions will also work for earlier versions of the software.

Adding a Title and Your Name to the Photograph

This is done in the Library module and is a good thing to do even if 

you don’t intend to submit an image to a PDI competition. Look in the 

right-hand panel and expand the section entitled Metadata, which is 

an alternative way of referring to the hidden data within an image file. 

Figure 1 shows the places where you enter the title of the photograph 

and your name. You may also like to set whether of not the image is 

copyright and enter the name of the copyright holder … which of 

course will be you. Setting the copyright information is recommended.

Setting the Correct Image Size and Colour Space

Unlike most other image editors, everything else you need to set is 

done when you export (save) your photograph. Select the image you 

want to export 

and from the 

File menu at the 

very top of the 

Lightroom 

window, choose 

Export… or press 

Ctrl-Shift-E. Next, 

and using figure 

2 as a guide, 

make sure you 

set the File 

Settings as 

shown to ensure 

the best image 

quality and 

correct sRGB 

colour space.

In the Image Sizing section tick the Resize to Fit box and for 

the ‘Long Edge’ enter either 1200 for portrait format 

images or 1600 for landscape format. Always check the 

tick box is set correctly when exporting images because 

Lightroom will not alter the state of the box until you 

change it.

Finally, click the Export button to create your PDI image as set within the Export Location section.

Fig.1 - the Metadata panel

Fig.2 - the Export dialogue
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Wolverhampton Photographic Society

Preparing PDI Photographs Using
Adobe Photoshop

The information provided here is based on Photoshop CC for Windows but these instructions are still a useful 

guide for other versions of the software.

Adding a Title and Your Name to the Photograph

Click the File menu at the top left of the Photoshop 

window and choose File Info to open a new window 

(figure 1) where you type the title and your name, as 

well as your copyright information. Entering these 

details is is a good thing to do even if you don’t intend 

to submit the image to a PDI competition and you can 

add other information of course, but it isn’t required for 

competition entries.

When you have finished click the OK button.

Resizing Your Image

WARNING:  Resizing your photo will permanently alter 

your image so be careful not to save it such that it 

overwrites your original copy. If your original file is in 

JPEG format always use the Save As option when saving 

the file after resizing.

Having got the warning out of the way, to resize your 

image by open the Image menu at the top of the 

Elements window then follow the Resize entry and 

choose Image Size… or press Alt-Ctrl-I. Either way, the 

Image Size dialogue window will open, as shown in 

figure 2.

Make sure the tick box is set as shown and the 

resampling type is also set as shown so Photoshop will 

optimise your image as its size is reduced. In other 

words, Bicubic Sharper (reduction).

Before you set the pixel dimension make sure the little 

chain-link icon is set as shown in figure 2 and if not, 

click it to make sure the proportions of your image are 

preserved. Next, if your photo orientation is landscape 

set the Width to 1600 or for portrait set the Height to 

1200. Enter only one dimension because the other is 

calculated automatically. When you have finished click 

the OK button.

Fig.1 - the File Info window

Fig.2 - the Image Size window
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Preparing PDI Photographs Using Photoshop

Setting the Colour Space and Saving Your PDI

WARNING:  If your original image is in JPEG format and 

you have resized it you must follow these instructions 

to avoid overwriting and destroying your original file.

To create your finished PDI JPEG image use the File 

menu at the top-left of the Photoshop window and 

choose Save As… or type Shift-Ctrl-S. This will open the 

Save As dialogue window as shown in figure 3.

• Choose the location where the file is to be saved

• Enter the file name of your image

• Make sure Save as Type is set to JPEG as shown

• Make sure the ICC profile is set to sRGB and is 

ticked. If the ICC profile does not indicate sRGB, 

as in figure 3, please see below

When you have done this and you are sure you are not 

going to overwrite your original image, click the Save 

button.

Setting the JPEG Quality

A new window will open which allows you to choose 

the quality used when the JPEG file is created. Use the 

settings shown in figure 4 to ensure your PDI is saved 

at the highest quality.

When you have finished click the OK button and your 

PDI will be created.

What if the ICC profile is not set to sRGB?

You will need to change this before you save your 

image because PDI entries must use the sRGB colour 

space.

To fix this, click the Cancel button then open the Edit 

menu at the the very top of the Photoshop window 

and choose Assign Profile…  A small window will then 

open and using the drop-down menu, choose the 

sRGB IEC61966-2.1 profile then click OK.

You may now follow the instructions on this page to 

save your PDI.

Fig.3 - the Save As dialogue window

Fig.4 - the JPEG Options window
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Wolverhampton Photographic Society

Preparing PDI Photographs Using
Photoshop Elements

The information provided here is based on Photoshop Elements 10 for Windows but these instructions are still a 

useful guide for other versions of the software.

Fig.1 - the File Info window

Fig.2 - the Image Resize window

Adding a Title and Your Name to the Photograph

Click the File menu at the top left of the Elements 

window and choose File Info to open a new window 

(figure 1) where you type the title and your name, as 

well as your copyright information. Entering these 

details is is a good thing to do even if you don’t intend 

to submit the image to a PDI competition and you can 

add other information of course, but it isn’t required for 

competition entries.

When you have finished click the OK button.

Resizing Your Image

WARNING:  Resizing your photo will permanently alter 

your image so be careful not to save it such that it 

overwrites your original copy. If your original file is in 

JPEG format always use the Save As option when saving 

the file after resizing.

Having got the warning out of the way, to resize your 

image open the Image menu at the top of the Elements 

window then follow the Resize entry and choose Image 

Size… or press Alt-Ctrl-I. Either way, the Image Size 

dialogue window will open, as shown in figure 2.

Make sure the tick boxes are set as shown and the 

resampling type is also set as shown so Elements will 

optimise your image as its size is reduced. In other 

words, Bicubic Sharper (best for reduction).

Having ticked the boxes now set the pixel dimension, so 

if your photo orientation is landscape set the Width to 

1600 or for portrait set the Height to 1200. Enter only 

one dimension because the other is set automatically.

When you have finished click the OK button.

Page 6
v2023.1



C
o

p
y
ri

g
h

t 
©

 R
o

b
 C

o
w

e
ll
/W

o
lv

e
rh

a
m

p
to

n
 P

h
o

to
g

ra
p

h
ic

 S
o

ci
e

ty
 2

0
2

2

Setting the Colour Space and Saving Your PDI

WARNING:  If your original image is in JPEG format and 

you have resized it you must follow these instructions 

to avoid overwriting and destroying your original file.

To create your finished PDI JPEG image use the File 

menu at the top-left of the Elements window and 

choose Save As… or type Shift-Ctrl-S. This will open the 

Save As dialogue window as shown in figure 3.

• Choose the location where the file is to be saved

• Enter the file name of your image

• Make sure Format is set to JPEG as shown

• Make sure the ICC profile is set to sRGB and is 

ticked. If the ICC profile does not indicate sRGB, 

as in figure 3, please see below

When you have done this and you are sure you are not 

going to overwrite your original image, click the Save 

button.

Setting the JPEG Quality

A new window will open which allows you to choose the 

quality used when the JPEG file is created. Use the 

settings shown in figure 4 to ensure your PDI is saved 

at the highest quality.

When you have finished click the OK button and your 

PDI will be created.

What if the ICC profile is not set to sRGB?

You will need to change this before you save your 

image because PDI entries must use the sRGB colour 

space.

To fix this, click the Cancel button then open the Image 

menu at the the very top of the Elements window. 

Follow the Convert Color Profile and choose the option 

Convert to sRGB Profile.

You may now follow the instructions on this page to 

save your PDI.

Preparing Your Photographs Using Photoshop Elements

Fig.3 - the Save As dialogue window

Fig.4 - the JPEG Options window
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Wolverhampton Photographic Society

Preparing PDI Photographs Using
Affinity Photo

The information provided here is based on Affinity Photo version 1.5 for Windows .

Adding a Title and Your Name to the Photograph

As of July 2017 Affinity Photo allows you to view 

EXIF/IPTC information in your image but doesn’t give 

the option to alter it. Future versions may address this 

but in the meantime you must use the facilities offered 

by Windows to add your title and name. Details of how 

to do this are given on the next page.

Setting the Colour Space

To ensure the sRGB colour space is used, open the 

Document menu at the top of the Affinity Photo window 

and choose Assign ICC Profile… which will open the 

window shown in figure 1. The profile currently in use 

will be highlighted with a blue bar so make sure the 

selection is as as shown then click the Assign button, or 

Cancel if nothing needed to be changed.

Setting the Correct Image Size and JPEG Quality

The size and quality of your PDI is set when you export 

your image, rather than when saving it, and means 

there is no risk of overwriting your original file.

Open the File menu at the top-left of the Affinity Photo 

window and choose Export… which will open the Export 

Settings window shown in figure 2. Choose the green 

JPEG icon at the top and use the settings shown to 

ensure your PDI is saved at the highest quality. In other 

words, select the preset JPEG (Best Quality) from the 

drop-down menu and Bicubic as the resampling type. 

Before you set the pixel dimension make sure the little 

padlock icon is set as shown in figure 2 and if not, click 

it to make sure the proportions of your image are 

preserved. Next, if your photo orientation is landscape 

set the left-hand box to 1600 px or for portrait set the 

right-hand box to 1200 px. Enter only one dimension 

because the other is calculated automatically.

Click the Export button to save your PDI.

Fig.1 - selecting the correct colour profile

Fig.2 - the Export Settings window
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Wolverhampton Photographic Society

Using Windows to Add
Title, Name and Copyright

The information provided here assumes the use of 

Windows 10 but these instructions are the same for 

Windows 7 or Windows 8. If you are still using the 

earlier versions of Windows, it really is time to upgrade 

because you leave your PC at risk of virus or malware 

infection and the potential loss of your files and 

photographs.

Adding a Title and Your Name to a Photograph

Use File Explorer* to find your image by clicking the 

right mouse button on the Windows logo at the 

bottom-left of the screen, then choose File Explorer 

from the menu that opens. Figure 1 shows a typical file 

window showing a folder containing a selection of 

photos. One of these has been renamed to be more 

meaningful than simply being an image number, like 

the others in this folder. The file name could be the title 

of the photograph but what you choose is up to you - 

the file name on your computer is not used when you 

submit your PDI entry via the WPS website. There may 

be specific file naming conventions for other 

competitions however, so it is always wise to check.

Place the mouse pointer over the relevant photo then 

click the right mouse button to open the menu and 

choose Properties - as in figure 1. A Properties window 

will then open which has four tabs at the top: click onto 

the Details tab which is represented by figure 2.

You can now change the IPTC data by clicking in the 

relevant fields as shown. As a minimum you should 

enter the Title of your photograph and add you as the 

Author. You can also enter yourself as the Copyright 

holder, which is recommended. Other information can 

be added, such as a star rating or key words (Tags) to 

help with searching, but this isn’t required for 

competition entries.

When you have finished click the OK button and the 

information you have entered will be written to the file.

Fig.1 - viewing the file Properties

Fig.2 - the file Details window

*called Windows Explorer in Windows 7
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Page 10

Wolverhampton Photographic Society

How to Submit PDI photos
to WPS Competitions

Before entering an image into a PDI competition you must ensure you can tick 

all of the following criteria:

 The image width is no more than 1600 pixels

 The image height is no more than 1200 pixels

 The image IPTC metadata has been updated to include (as a 

minimum) the entry title and your name

 The image uses the sRGB colour space

 The image is saved as a JPEG file (.jpg) with the quality set to 

maximum

 The file size of the image is less than 2Mb

Regarding the file size, in the unlikely event it is greater than this limit you can 

reduce its size by re-saving it using a slightly lower setting for the JPEG quality. 

Using 90%, or 10 instead of 12, will reduce the size but will have little impact on 

perceived image quality. Of course, the highest quality is always best if possible.

Fig.1 - enter up to three images

using the PDI submission page

The WPS PDI Competition Page

Using the menu link shown in figure 1 you will arrive at the WPS PDI Competition page where you can submit 

your entries for any of the three rounds. You don’t have to submit all your entries in one go of course, but you 

will need to submit entries for any given round by the closing date for that round. You will find all the 

information you need on this page including general information, submission and competition dates, WPS 

competition rules and the PDF version of this document.

Submitting Your Entries

The form on the page allows you to send your photos for entry into PDI competitions. It is straightforward to 

use but you will need a valid Entry Code to prove you are a full member of Wolverhampton Photographic Society.

When you are given this code please keep it secret and do not pass it on to others.

Most fields on the form are mandatory so you will not be able to Submit Your Entry unless you have provided 

relevant information in the fields shown in figure 2, indicated with an arrow.

Fig.2 - you must complete the fields shown
v2023.1
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Page 11

Figure 2 shows a typical view of the form but it may look slightly different depending on the Internet browser you 

use. It has been tested using Chrome, Internet Explorer, Microsoft Edge and Firefox and has also been tested using 

an iPad with Safari and Chrome. There is therefore no reason to believe it won’t work with other Apple systems.

Notes on Completing the Fields

As mentioned above, most of the fields are mandatory and must be completed but you only need to submit one 

image to successfully submit the form. The following fields must therefore be filled-in:

Your Name: Enter your first name and surname eg: Sally Smith

Your email address: So that you will be sent an email to confirm your entry

Title of Image 1: Your image title of 30 characters maximum eg: Sunset on Ice

PDI Image 1: Use the button to browse your computer and select the image for submission

Level: Choose if you are entering the Novice or Advanced section

Competition Round: Choose which of the three rounds you’d like to enter your image(s)

Entry Code: Enter the Entry Code you have been given … it is not case sensitive

If you want to clear the form of all your entries, click the Start Again button.

When completing fields only use normal characters and/or numbers and do not include punctuation or symbols. 

You must not use   \  /  :  *  ‘  "  ?  , <  >  |  because your entries will be stored as computer files and those 

characters are not allowed in Windows file names. If you do use characters which aren’t allowed in a given field, or 

do not complete a mandatory field, then when you submit your entry the system will list any errors you have 

made and ask that you go back and make corrections. If your entry is submitted successfully the system will 

confirm this and send you an email summarising your entry. It will also copy the email confirmation to the 

Competition Secretary and to the Technical Officer responsible for projecting the entries on competition night.

How do I remove an entry after it has been submitted?

Please email competitions@wolverhamptonps.co.uk to request your entry be removed.

I only submitted one image. How do I submit the rest?

Simply go to the WPS PDI Competition page and use the form again to submit your other entries. The maximum is 

strictly three images per round and if you submit more than this your three images will be chosen at random.

I have successfully submitted an image but want to replace it with an improved version

Submit your entry again using exactly the same title you used before then your previous version will be 

overwritten, but note the information you enter is case sensitive so the title Northern Lights is treated as a new 

entry if you then call it northern lights.

Can others see the images I have submitted?

No. It is impossible for anyone to see competition entries other than those who have administrative access to the 

WPS website. Currently, that is the Chairman and the Technical Officer.

When I submit the form I am shown an error page saying ‘Server Error’

A Server Error is most likely caused when you try to submit an image file which exceeds the size limits set by the 

company hosting the WPS website. Individual PDI images must be less than 2Mb.

I have tried submitting my images using the website but can’t get it to work

You need help. Please email pdi@wolverhamptonps.co.uk giving as much detail as possible about the problem you 

are experiencing.

v2023.1
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